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DISCLAIMER 

This document was prepared as an account of work sponsored by the United States 
Government. While this document is believed to contain correct information, neither the 
United States Government nor any agency thereof, nor the Regents of the University of 
California, nor any of their employees, makes any warranty, express or implied, or 
assumes any legal responsibility for the accuracy, completeness, or usefulness of any 
information, apparatus, product, or process disclosed, or represents that its use would not 
infringe privately owned rights. Reference herein to any specific commercial product, 
process, or service by its trade name, trademark, manufacturer, or otherwise, does not 
necessarily constitute or imply its endorsement, recommendation, or favoring by the 
United States Government or any agency thereof, or the Regents of the University of 
California. The views and opinions of authors expressed herein do not necessarily state or 
reflect those of the United States Government or any agency thereof or the Regents of the 
University of California. 
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Microsoft 
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Disclaimer 

CaiTOX is a research model and has not been fully tested for.a broad range of 
applications. There could be errors in th~ mathematical algorithms that we have not yet 
identified. There are many different-brands of PCs and multiple versions of Windows 
and Excel currently in use, and it was not possible to test CaiTOX on the full spectrum of 
machine/software/printer combinations withwhich it could be used. Problems may occur 
in the execution of macros and in the display and printing ofthe spreadsheet information. 
This program should be considered as a research tool, and not used for regulatory 
decision making. Additionally, we cannot offe_r technical support for the program at 
this point in time. 
More information is available at http://eetQ..ibLgbv/ied!~r(:l· ·. 
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II ABSTRACT 

CalTOX has been developed as a set of spreadsheet models and spreadsheet data sets to 
assist in assessing human exposures from continuous releases to multiple 
environmental media, i.e. air, soil, and water. It has also been used for waste 
classification and for setting soil clean-up levels at uncontrolled hazardous wastes 
sites. The modeling components of CalTOX include a multimedia transport and 
transformation model, multi-pathway exposure scenario models, and add-ins to 
quantify and evaluate uncertainty and variability. All parameter values used as inputs 
to CalTOX are distributions, described in terms of mean values and a coefficient of · 
variation, rather than as point estimates or plausible upper values such as most other 
models employ. This probabilistic approach allows both sensitivity and uncertainty 
analyses to be directly incorporated into the model operation. This manual provides 
CalTOX users with a brief overview of the CalTOX spreadsheet model and provides 
instructions for using the spreadsheet to make deterministic and probabilistic 
calculations of source-dose-risk relationships. 

KEYWORDS: Exposure assessment, mass-balance model, multi-pathway exposure, 
probabilistic models 
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Ill. INTRODUCTION 

This manual provides CalTOX users with an overview of the CalTOX spreadsheet 
model and instructions for making calculations with this spreadsheet. We explain the 
layout of the spreadsheet and explain the use of Visual Basic algorithms that have 
been included to assist in making CalTOX calculations. This manual does not provide 
an extensive description of the model algorithms and its potential applications~ 
Technical support documents provide more detailed information about the CalTOX 
model and its development, validation, and potential applications. These doq1ments 
are available from the Technical and Electronic Information Department (TEID) at 
Lawrence Berkeley National Laboratory or from our web site: 
<http://eetd.lbl.gov/ied/era>. 

What is CalTOX? 

Environmental Scientists at the University of California campuses and national 
laboratories developed CalTOX as a spreadsheet model to assist in health-risk 
assessments that address multimedia pollutants. That is, pollutants that are emitted to 
and transferred among air, soil, surface water, sediments, and ground water. This 
spreadsheet model includes three components-a multimedia transport and 
transformation model, exposure scenario models, and components that quantify· arid· 
evaluate parameter variability and uncertainty. 

The multimedia transport and transformation model is a dynamic model that. can ·be­
used to assess time-varying concentrations of contaminants that are placed in soil 
layers at a time-zero concentration or contaminants released continuously to air,· soil; 
or water. This modelassists the user in examining how chemical and lands<::ap~: __ ,_ 
properties and exposure factors impact both the ultimate route and quantity ofhuman 
contact. 

Multimedia, multiple pathway exposure models are used in the CalTOX model to 
estimate average daily potential doses within a human population linked to a· 
pollutant source. The exposure models encompass twenty-three exposure pathways. 
The exposure assessment process consists of relating contaminant concentrations in 
the multimedia model compartments to contaminant concentrations in the media 
with which a human population has contact (personal air, tap water, foods, household 
dusts soils, etc.). The average daily dose is the product of the exposure concentrations 
in these contact :media and an intake or uptake factor that relates the concentratibhs to 
the potential dose within the population. · · 
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CalTOX has been designed to provide users with the options of: (1) making point 
estimates of average exposure during an exposure duration, (2) applying a sensitivity· 
analyses to these point estimates, (3) using a Monte Carlo add-in to make stochastic 
estimates of the distribution of exposure uncertainty /variability, and (4) applying a 
sensitivity analysis to the results of the Monte Carlo analysis to determine the variance 
contributions of model inputs to the overall variance in the estimated· distribution of 
exposure and risk 

Computer Requirements 

The min~mum hardware requirements for running the CalTOX spreadsheet are a 
personal computer (PC) with a mouse, capable of running Microsoft Excel97 or Excel· 
2000 for Windows, and able to "unzip" files compressed using "zip". 

CalTOX requires approximately 2 megabytes of storage space. Additional storage space 
is required to save and store specific CalTOX sheets. The CalTOX spreadsheet cannot be 
executed from a floppy-disk drive. A black and white monitor is sufficient, but a color 
screen is preferable. · 

The Cal TOX spreadsheet was designed and assembled using Microsoft .Excel 200Q. All 
of the initiaJ testing and debugging has been carried out using Excel2000. This version 
has been run on a number of PCs. but has not been tested on all possible computers. If 
you have diff~culty viewing, operating, or printing CalTOX, please see the Probl~ms 
Section of this manual. - · 

Knowledge ,Requirements 

In preparing this guide, we assume that you have a basic familiarity ,with spreadsheet. 
calculations and are familiar with the CalTOX documentation, which. describes the 
theoretical basis for the model. The material included in the CalTOX reports is. not 
repeated in this. manual. Users without a solid understanding of the human exposure 
intake equations and the fugacity-based compartment model will only be able to use 
the model superficially, if at alL 

Excel Spreadsheet Program 

CalTOX is designed to work with either Microsoft Excel 97 or Microsoft Excel2000. We 
have developed macros that allow you to load data, operate the CalTOX ~orksheet, 
and view the results o~ a CalTOX calculation with a minimum understanqing of Excel. 
Nonetheless, those with a more in-depth understanding of Excel will be able to master 
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the operations of CalTOX more rapidly and be more comfortable making their own 
modifications to the program execution. 

Fugacity Mass-Balance Models 

CalTOX includes an eight-compa.rtment regional and dynamic multimedia fugacity 
model. For all chemicals, fugacity and fugacity capacities are used to represent mass 
potential and mass storage within compartments. The eight compartments used· in 
CalTOX are (1) air, (2) ground-surface soil, (3) plant leaves, (4) plant leaf surfaces, 
(5) root-zone soil, (6) the vadose-zone soil below the root zone, (7) surface water, and 
(8) sediments. Contaminant concentrations in ground water are currently based on a 
simple mass balance. CalTOX accounts systematically for.gains and losses in each . 
compartment and for the whole system in concert. Understanding the results of the 
CalTOX spreadsheet requires a basic familiarity with this model, which is described in 
the CalTOX reports (DTSC, 1993a, 1993b, 1993c; McKone at al., 2002). 

Probabilistic Add-in Program 

CalTOX was designed to have both sensitivity and uncertainty analyses incorporated 
directly into the model operation. Parameter values suggested for use in CalTOX are 
described in terms of mean values and coefficients of variation in place of plausible 
upper values. Model results are described in terms of the confidence intervals· 
associated with model predictions. CalTOX has its own routine for carrying out a 
sensitivity analysis on point estimates ofexposure and risk. CalTOX is designed to 
integrate with the add-in program. Crystal Ball, wll1ch can be used to carry out 
sensitivity and ·uncertainty analyses with the results produced by CaiTO X. In order to 
use Crystal Ball, the user must be familiar both with the operation of Crystal Ball and 
with the techniques of uncertainty I sensitivity analysis. The current version of · 
CalTOX has been set up for use with Crystal Ball version 4.0, which is available as an 
add-in program for b9th ExceJ 97 or 2000. 

Applications Limitations 

As is the case with any model, CalTOX was designed for use in a limited range of 
spatial scales, time scales, geographic conditions, and chemical classes. These technical 
limitations apply to version 4.0 of CalTOX. Future versions of the model may be 
modified to overcome these limitations. 

Chemical Limitations 

CalTOX is designed primarily for non-ionic organic chemicals and inorganic chemicals 
with linear and reversible distribution coefficients in soil and sediments. CalTOX was 
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also designed to model emissions that can be treated as uniform over a region. 
CalTOX has not been designed or tested for surfactants or volatile metals. It can be 
used for partially ionized organic chemicals only when great care is exercised to adjust 
the partition coefficients to confirm that they are appropriate for the pH of the 
landscape under consideration. The model is further limited to chemicals for which 
one has reliable values for physical and chemical P':lrarneters. 

Time Scale Limitations 

The CalTOX transport model is intended for application over long time scales, months 
to years. It should be used cautiously for time periods less than one month and then 
only when properly time-averaged landscape properties are employed: Whe·n this is 
not the case, CalTOX can be used, hut some discount of model reliability must be 
considered. 

Landscape Limitations 

CalTOX should not be used for landscapes in which water occupies more than 10% of 
the land surface area. If an area is too small, it is flagged by·an error message in the 
program. 

The Philosophy of CaiTO X 

CalTOX has been subjected to extensive scientific peer review, and we believe that 
CalTOX is a state-of-the-art model for making regional multimedia exposure· 
assessments. The objective of CalTOX is to improve the transparency of exposure 
information used in support of regulatory decision-making. This objective requires a 
model in which the user can track calculations and assmp.ptions, a model thpt is 
relatively easy to use and flexible, a model that provides output in a timely and reliable 
fashion, and an explicit treatment of paramete~ uncertainty. We anticipate that the 
science supporting risk assessment will continue to evolve and that common·- -­
assumptions will change. CalTOX wa~ planned so that new information and 
algorithms can be readily incorporated in the spreadsheet templates as this 
information becomes available. 

Overview of this Manual 

The remainder of this document is divided into seven sections. Section 2 gives the 
user a step-by-step set of instructions for loading the program and using the 
spreadsheet. Section 3 explains how to start and run a sample problem using the 
CalTOX macro and worksheet fi.les. ~ection 4 identifies a number of common 
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problems and provides remedies. Section 5 provides a summary of the CalTOX 
worksheet and identifies what is included in each of the eighteen pages of this 
worksheet. Section 6 explains the calculation of risk and soil clean up goals. Sections 7 
and 8 deal respectively with sensitivity and uncertainty analyses . 
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~2. GETTING STARTED 

The CalTOX file can be downloaded from <http:/ /eetd.lbl.gov /ied/era> or obtained as 
a zip file on a 1.44 Megabyte disk. This disk is locked and should not be used to run the 
program, since there is not sufficient room on this disk to contain the files created 
during the execution of the CalTOX macros. 

Hard disk Configuration 

Before copying the zip file onto your hard disk, create a new sub-directory or folder on 
your hard disk. The name CalTOX is an obvious choice, but any name will do. Copy 
the zip file from the CalTOX floppy disk or from our download site into the new sub­
directory or folder of your hard disk. Store the master disk in a safe place. Open the. 
directory or folder in which you have copied CalTOX.zip and extract all of the files into 
this subdirectory or folder using an unzipping program such as Winzip. The files that 
will be extracted are CalTOXtemplate.xls, userinfo.txt, CalTOXmanual.pdf, and any 
other currently available support files. 

IMPORTANT: 
The name of the CalTOX file must remain "CalTOXtemplate.xls". This name should 
not be changed. If it is renamed, the macros written for CalTOX will no longer work. 

If you would like to store multiple copies of CalTOX, place them in different locations 
so that the name can remain "CalTOXtemplate.xls". If you create copies of CalTOX, 
you must also copy the file "userinfo.txt" into the same subdirectory or folder. If this is 
not done, the help option in the CalTOX menu will not work. 

The CaiTO X Workbook 

The CalTOX workbook contains eight worksheets. Most of these sheets are used only 
by the Visual Basic macros and do not need to be view or modified by the user. When 
you start the program, there are only two sheets that will be visible to you. These 
sheets are the following: 

6 

Run Cal 

CaiTO X 
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There are six other sheets that are used by CalTOX which are not visible and they are 
the following: 

Contaminated Soil 

Continuous Emission 

DatCal 

InputLists 

Sensitivity 

All Chemicals 

The type, contents, and purpose of eachworksheet are as follows: 

Run Cal is a worksheet that is used as a menu to easily perform the CalTOX 
operations. This sheet contains several different buttons that carry out different 
operations when activated. These button·s are explained in the next section. 

CalTOX is the primary worksheet used for making user-specified calculations. 
The actual "CalTOX" worksheet is built up from one of two templates. This is a 
very large spreadsheet and includes the scenario-specific input tables, output 
tables, graphical outputs and all intermediate calculations that are involved in the 
process of estimating the environmental distribution of a chemical, transfer to 
exposure media, human contact, and potential health risk. 

Contaminated Soil is a worksheet template. This template contains a spreadsheet 
that uses algorithms applied to soil compartments that are already contaminated. 
This template is one of the two sheets (the other being Continuous Emission) 
used to create a "CalTOX" spreadsheet. 

Continuous Emission. is a second worksheet template. This template contains a 
spreadsheet that applied to soil and other compartments that are initially clean 
and then contaminated over time due to continuous emissions to air, soil, and/ or 
water. This template is one of the two sheets (the other being Contaminated Soil) 
used to create a "CalTOX" spreadsheet. 

DatCal is a worksheet that contains a listing of chemical properties, landscape 
properties, and human exposure factors required as input for CalTOX. Mean 
values and coefficients of variation for each input are listed for numerous 
chemicals, several landscapes in the United States, and several exposure factors 
(see Philosophy of CalTOX). This worksheet is hidden from view. The chemical, 
landscape, and exposure factor data in this worksheet will be automatically loaded 
into the main CalTOX spreadsheet by macro- commands that are initiated from 
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the use of drop down menus on the CalTOX spreadsheet. New chemical data, 
landscape properties, and exposure factors can be added with the use of buttons on 
the RunCal sheet. 

InputLists is a worksheet that contains a list of the names of chemicals, landscape 
properties, and exposure factors. This worksheet is used by the drop down menus 
on the CalTOX sheet to cross reference and select data from DatCal and load it into 
CalTOX. 

Sensitivity is a worksheet template. This template is used by the sensitivity 
analysis macro to display the results of the sensitivity analysis. A row is included 
for each parameter used in the sensitivity analysis. Each row includes a column 
to summarize the mean (or reference) value of_ the parameter, its coefficient of 
variation, the measure of local sensitivity, and the overall sensitivity score. 

AllChemicals is a worksheet template. This template .is u.sed by a macro that runs 
through all the chemicals.contained in the DatCal .sheet. For each chemical, the 
data is entered into the CalTOX spreadsheet and the resulting risk and hazard 
ratio values are recorded into a copy of this template. 

i• 
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113. USING CalTOX 

Starting CalTOX 

To start CalTOX, launch the file named CalTOXtemplate.xls. This can be done in 
Windows by double clicking on the icon for this file or by opening the 
CalTOXtemplate.xls file from within the Excel application. 

After the program is initiated, a dialog box will appear asking you which CalTOX 
template you would like to use to create a new scenario. There are two models that 
you can choose from. These models are Contaminated Soil and Continuous Emission. 
The Contaminated Soil model uses algorithms that assume the soil is initially 
contaminated. The Continuous Emissions model uses algorithms that assume the soil 
is initially clean and is contaminated over time due to the continuous emission of a 
chemical into ail, soil, or water. After you have selected the desired template, press the 
"OK" button. This will create a sheet called "CalTOX". The CalTOX spreadsheet will 
contain a copy of the template that was selected from the dialog box below. 

If you prefer to use a CalTOX sheet that has been saved previously, press the "Cancel" 
button. RunCal will be the only sheet open. To use a previously saved sheet, click the 
"Import Saved Scenario" button. 

Once you have made your selection ,on the dialog box, the CalTOX Control Panel will 
appear. If you selected a model to begin a new scenario, there will also be a sheet 
named "CalTOX" open, indicated by the tab at the bottom of the screen called 
"CalTOX". If you chose not to begin a new scenario, there will not be a sheet named 
"CalTOX" open. The picture below is a sample of what the Excel window will look like 
once the dialog box is gone. 

Lawrence Berkeley National Laboratory 9 
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5! Microsoft Excel · CaiTOX4.xls '· •• : • '' ' ~ 'Jl?llii~\r{l" f;"JJ!3 

CaiTO X™ Control Panel 

Figure 1. CalTOX Control Panel 

Using the CalTOX Control Panel 

The buttons on the CalTOX Control Panel operate macros that automatically carry out 
CalTOX operations. The following sections give explanations on how to use these 
buttons. ' 

Begin New Scenario 

When the "Begin New Scenario" button is selected, a dialog box will appear on the 
screen. It is the same dialog box that appears when CalTOX is first loaded. Use the 
menu to select the template you would like and click the "OK" button. This will open 
a sheet called "CalTOX" containing the template that was chosen with the use of the 
dialog box. 
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IMPORTANT: 
If a sheet called "CalTOX" already exists, it will automatically be overwritten with the 
new sheet. If you wish to save the current CalTOX spreadsheet and have not done so 
already, click the "Save Scenario" button before beginning a new scenario. 

Always use the "Save Scenario" button to Save a CalTOX spreadsheet. DO NOT use 
the Excel "Save" commands. Using the Excel "Save" or "Save As" commands can 
over-write or alter the CalTOXtemplate workbook. Always make sure you store an 
original version of the CalTOXtemplate in a safe place as a backup. 

Import Saved Scenario 

If you wish to work on a sheet that already exists, you should click the "Import Saved 
Scenario" button to have it copied back into the CalTOX workbook. When the "Import 
Saved Scenario" button is activated, you will be asked to select the file that contains the 
sheet on which you want to work. 

After you choose the file, the sheet will be copied into CalTOX and named "CalTOX". 
If a sheet called "CalTOX" already exists, it will automatically be overwritten with the 
new sheet. If you wish to save the current "CalTOX" sheet and have not done so 
already, click the "Save Scenario" button before importing a saved scenario. 

Lawrence Berkeley National Laboratory 11 
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Choose a Chemical 

Selecting the "Choose a Chemical" button transports you to the first page of the 
CalTOX spreadsheet. To choose a chemical, use the top-most drop down menu, which, 
as shown below, is indicated by the words "Chemical==>" to the left of the drop 
down. Once you choose a chemical from the menu, the data will be loaded into the 
CalTOX spreadsheet and the algorithms will be recalculated automatically. 

CaiTO X™ 4.0 beta: Eight.:.compartm'tmt Multime_dia Exposure Mo-del - Contaminated · SoiH~ 
Copyright (c) 2902 Regef11s ofti:Je Un~(sity ,Qf ~alifornia 

Landscape ==i> ... 
Exposure 'Factoffi S~t=> · 

Un-mitigated ris 
(m g/kg-d) Risk 

· ' l'r.halation ·f--'-=-=-,-::e..:.-+----'o;__---1 Hazard ratio 
ingestion 1.0 E·01 0 

Toxicity Data==> 

Use this drop-down 
menu to select a 
chemical. 

<' D.erma~. c......:,.1 =-0-=E-,-=· 0'-'-1 -+----'0:.___---1 Target Soil Concentrations (in ppm) 
· > TOtal dos~ ; ;;; , . · · o 

Choose a Landscape 

Selecting the "Choose a Landscape" button transports you to the first page of the 
CalTOX spreadsheet. To choose a landscape property, use the middle drop down menu 
which, as shown below, is indicated by the words "Landscape Property==>" to the left 
of the menu. Once you choose the landscape property from the menu, the data will be 
loaded into the CalTOX spreadsheet and the algorithms will be recalculated 
automatically. 

Choose an Exposure Factors Set 

Hazard ratio 

Use this drop-down 
menu to select a 
landscape. 

Target Soil Concentrations (in ppm) 

Selecting the "Choose an Exposures Factor Set" button transports you to the first page 
of the CalTOX spreadsheet. Similar to the process for selecting chemical and landscape 
properties, to choose an exposure factor set, use the last drop down menu as indicated 
by "Exposure Factor ==>" to the left of the menu. Once you choose an exposure factor 
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from the menu, the data will be loaded into the CalTOX spreadsheet and the 
algorithms will be recalculated automatically. 

Set Pathway Toggles 

Selecting the "Set Pathway Toggles" button transports you to page 8 of the CalTOX 
spreadsheet. On this page, there is a list of the exposure pathways that can be turned 
on or off for any calculation by setting cell values to 1 or 0. There are two large 
columns that contain brief descriptions of the pathways that can be turned on or off. 
Next to these columns are narrow columns, which contain either a "1" or a"O". A "1" 
indicates a pathway or exposure medium that is "on" and a "0" indicates a pathway 
that is "off". Only "1" or "0" should be entered in these columns. By default, the 
CalTOX spreadsheet is pre-loaded with all pathway toggles set equal to 1, that is, in the 
"on" position. 

Save Scenario 

The "Save Scenario" button allows you to save the CalTOX spreadsheet in a separate 
workbook. When the "Save Scenario" button is activated, you will be asked to select 
the location in which you want the workbook saved and the name of the workbook. 
Characters that are not allowed as parameter names in Excel, such as, blanks, commas, 
hyphens, plus signs, etc., CANNOT be used in this name. (Consult the Excel manual 
for a full list of restricted characters. The underline character "_" and numbers ARE 
allowed in this name.) 

IMPORTANT: 
If you select a name that already exists in the current directory, any file with that name 
will automatically be overwritten. 

And as noted above: 
Always use the "Save Scenario" button to Save a CalTOX spreadsheet. DO NOT use 
the Excel "S~ve" commands. Using the Excel "Save" or "Save As" commands can 
over-write or alter the CalTOXtemplate workbook. Always make sure you store an 
original version of the CalTOXtemplate in a safe place as a backup. 

After you specify the location and name of the file, click the "Save" button. The 
CalTOX spreadsheet will then be copied into the specified workbook and saved. The 
drop down menus cannot be used in the saved files. Therefore, the only choices from 
the drop down menus are the chemical, landscape, and the exposure factors set that 
were selected in CalTOX. The workbook will remain open after this process is 
complete. Remember to save this new CalTOX workbook if you make any changes to 
the spreadsheet. 
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IMPORTANT: 
Always use the Save Scenario button before using the Sensitivity Analysis or Run 
Through All Chemicals buttons. 

Perform a Sensitivity Analysis 

The "Perform a Sensitivity Analysis" button is used to carry out sensitivity analyses on 
a saved CalTOX spreadsheet. More details on what actions this macro initiates are 
described in the section below on sensitivity analysis with CalTOX. When the 
sensitivity analysis is started, the following dialog box appears and the user is asked 
choose to perform an analysis on either the Risk or the Hazard Ratio of the chemical. 

The CalTOX spreadsheet must already be saved to perform a sensitivity analysis on it. 
After the "OK" button is clicked, you will be asked to specify the file on which you 
would like to perform the sensitivity analysis. This file should be a saved workbook 
that contains the CalTOX spreadsheet. Once the sensitivity analysis is finished, it will 
be saved in the same workbook as the CalTOX spreadsheet on which it was performed. 
This new spreadsheet will be named "Sensitivity- Risk" or "Sensitivity- Hazard 
Ratio", depending on which end point was analyzed. If a sensitivity analysis has 
already been saved in the workbook, it will automatically be overwritten by the new 
analysis. 

Run Through All Chemicals 

When the "Run Through All Chemicals" button is pressed, it will begin the process of 
recording the Risk and Hazard Ratio of every chemical contained in the DatCal sheet. 
The Save Scenario button should be used before using to Run Through All Chemicals. 
After the "Run Through All Chemicals" process starts, you will be prompted to choose 
the location and file name for the workbook in which you wish to save the new 
worksheet that will be generated by this process. Choosing the location and naming 
the file should be done in the same manner as the "Save Scenario" process. After you 
indicate the location and name of the workbook, the process of running through every 
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chemical will begin. Because this takes some time to complete, the status bar at the 
bottom of the Excel window will indicate that the new sheet is being generated as 
shown below. 

Once the process is complete, the status bar will say "Ready". The workbook in which 
you saved the sheet will remain open, and the visible sheet will be named 
"ChemicalRun." 

Note that there are three extra columns on the ChemicalRun sheet named "Quantity 
1", "Quantity 2", and "Quantity3". These cells can be used to record three output 
values in addition to the risk and hazard ratio that are determined for all the 
chemicals contained in DatCal. You select which outputs to use by entering their cell 
locations on the CalTOX spreadsheet into three cells in the column next to the risk and 
hazard ratio values. These three cells are J8J9, and JlO. As an example, if you want to 
see the fugacity capacity of pure air, the offsite air concentration, and the concentration 
limit for ground water for all chemicals, you would enter "=AE3", "=P181", and 
"=H24" into the cells JS, J9, and JlO, respectively. This example is shown in the figure 
below. 

Useihese 
cells to add 
outputs to the 
Run through 
All Chemicals 
process. 

As shown by the formula bar, cell JS has the value equal to that in cell AE3. On the 
ChemicalRun sheet, Quantity 1, Quantity 2, and Quantity 3 will be the fugacity capacity 
of pure air, tJ:l_e offsite air concentration, and the concentration limit for ground water, 
respectively. 
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Perform an Uncertainty Analysis 

Choosing the "Perform an Uncertainty Analysis" button causes the dialog box below to 
appear. An uncertainty analysis can be performed on any CalTOX spreadsheet by 
adding in a Monte Carlo program, such as Crystal Ball. More details on how this is 
done are described in the section on uncertainty analysis with CalTOX. This button 
only gives brief instructions on how to perform an uncertainty analysis using Crystal 
Ball. It does not perform the actual uncertainty analysis. 

Add a Chemical 

The "Add a Chemical" process is used to automatically add a new chemical into 
CaiTO X. When the "Add a Chemical" button is clicked, the form shown below will 
appear. 

16 University of California 



CalTOX User's Guide 

On this form, there are spaces to enter the name of the chemical, the mean value of 
the chemical properties, and the coefficients of variation for measurement or 
estimation of that property. Fields on this form that require an entry are marked with a 
'*'. When you are finished entering the data on this form, click "OK". When the "OK" 
button is clicked, there will be a check performed to find any blank fields. If any of 
these fields left blank are required fields, the form will reappear and you will need to 
re-enter all of the data. If any fields that are not required are left blank, a default value 
algorithm will be used to determine these parameters. Once you have successfully 
entered the data, the next form will appear for you to continue entering the mean 
values and coefficients of variation for other chemical properties. There are three 
forms used to enter a single new chemical into CalTOX. The check for blank fields will 
be performed on all three forms. Once the data have been entered on all three forms, 
the chemical will be entered into DatCal and will be available in the drop down menu 
on the CalTOX spreadsheet for all future runs of the CalTOXtemplate. It will be the 
last chemical in the list. At anytime during this process, you may click "Cancel" and 
the chemical will not be entered into CalTOX. 
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Add a Landscape 

The "Add a Landscape "process is used to automatically add a new landscape data set 
into CaiTO X. When the "Add a Landscape" button is clicked, the form shown below 
will appear. 

On this form, there are spaces to enter the name of the new landscape properties set, 
the mean value of the landscape properties, and the coefficients of variation for each 
property. All fields on this form require an entry. When you are finished entering the 
data on this forr_n, click "OK". When the "OK" button is clicked, there will be a check 
performed to find any blank fields. If any fields are left blank, the form will reappear 
and you will need to re-enter all of the data. Once you have successfully entered the 
data, the next form will appear for you to continue entering the mean values and 
coefficients of variation for landscape properties. There are three forms used to enter a 
new landscape into CalTOX. The check for blank fields will be performed on all three 
forms. Once the data have been entered on all three forms, the new landscape 
properties set will be entered into DatCal and is available in the drop down menu on 
the CalTOX spreadsheet. It will be the last landscape in the list. At anytime during this 
process, you may click "Cancel" and the landscape property will not be entered into 
Cal TO X. 

18 University of California 



CalTOX User's Guide 

Add an Exposure Factors Set 

The "Add an Exposure Factors Set" button is used to automatically add a new set of 
exposure factors into CaiTO X. When the "Add an Exposure Factors Set" button is 
clicked, a form similar to those for adding a chemical and adding a landscape will 
appear. On the exposure factors forms, there are spaces to enter the name of the new 
exposure factors set, the mean values for the various exposure factors, and their 
coefficients of variation. All fields on this form require an entry. When you are 
finished entering the data on this form, click "OK". When the "OK" button is clicked, 
there will be a check performed to find any blank fields. If any fields are left blank, the 
form will reappear and you will need to re-enter all of the data. Once you have 
successfully entered the data, the next form will appear for you to continue entering 
the mean values and coefficients of variation for the exposure factors. There are three 
forms used to enter a new set of exposure factors into CalTOX. The check for blank 
fields will be performed on all three forms. Once the data have been entered on all 
three forms, the exposure factors set will be entered into DatCal and is available in the 
drop down menu on the CalTOX spreadsheet. It will be the last exposure factors set in 
the list. At anytime during this process, you may click "Cancel" and the exposure 
factors set will not be entered into CalTOX. 

Quitting CalTOX 

To quit CalTOX properly, you must either use the "Quit CalTOX" button on the 
RunCal sheet or select "Quit CalTOX" from the CalTOX menu bar (see description 
under the Viewing Spreadsheet Results section below). Using either of these methods 
will close the CalTOX workbook, but Excel will remain open. If you do not use either 
of these methods to quit CalTOX, the CalTOX menu bar may not be removed properly 
causing problems the next time you run Excel or CalTOX. See the problems section for 
details on fixing a CalTOX menu problem. 

Viewing the Spreadsheet Results 

A number of macros and macro-initiating buttons and commands are included in the 
CalTOX environment so the user can quickly and easily load data, switch from one 
spreadsheet window to another and locate inputs and outputs in the CalTOX 
spreadsheet. There are two items that can be used to operate these macros-the 
"RunCal" worksheet that was described above and the CalTOX menu on the CalTOX 
menu bar. The CalTOX menu is described below. 
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The CalTOX Menu Bar 

The CalTOX menu bar differs from the standard Excel menu bar by the presence of the 
"CalTOX" menu. This menu is created automatically when CalTOX is loaded. The 
appearance of the CalTOX menu bar is illustrated below. The "Cell", "Run", or 
"CBTools" menus shown below are for Crystal Ball. 

The CalTOX Menu 

The CalTOX menu includes a list of commands that can be used to view different parts 
of the CalTOX spreadsheet. Each command name includes a brief description of the 
table or object in the CalTOX worksheet that can be viewed using that command. Also 
listed is the spreadsheet page number corresponding to the table or object. The CalTOX 
menu can also be used to reset the window view to either the RunCal sheet or the 
home page of the CalTOX spreadsheet. An illustration of the CalTOX menu is 
provided below. 
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Printing Results 

The "File Print" in the menu bar can be used to print out any of the CalTOX files that 
can be located in the "Window" menu. Any file created from the CalTOX spreadsheet 
template has the print area already defined so that the print command causes all pages 
of the CalTOX worksheet to be printed out in landscape format on 8 1/2 by 11 inch 
paper. To be sure that the whole page fits on each page, select the "Print Preview" 
option from the File menu. If the pages are too large, decrease the percent of normal 
size in the scaling section of the "Page Setup" option in the File menu. 
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114. PROBLEMS 

There are many different brands of PCs and multiple versions of Windows and Excel 
currently in use, and it was not possible to test CalTOX on the full spectrum of 
machine/software/printer combinations with which it could be used. Thus, problems 
may occur in the execution of macros and in the display and printing of the 
spreadsheet information. 

What to do if a Macro-Interrupt Occurs 

In Excel, an error during the execution of a macro causes a "run-time error" message to 
be displayed. When this happens, the user is given the option to "End," "Debug," or 
"Help." If this display appears, the user should select "End" and get back to the RunCal 
sheet and try to run the macro again. If problems continue, quit CalTOX and restart. 

Multiple CalTOX Menu Bars 

If CalTOX is not quit properly each time, multiple CalTOX menu bars can begin to 
accumulate in the Excel menu. To get rid of any extra CalTOX menu bars, select 
"Customize" from the Tools menu. Click on each CalTOX menu bar and drag it into 
the Customize window and let go. This will delete all CalTOX menu bars. Close 
CalTOX by selecting File-> Close. Reopen CalTOX to create a fresh menu bar. 

Screen Displays and Zoom Scaling 

On PC computers, the CalTOX worksh~et is preset for display at 90% of full size. On 
some computer ·screens this scaling is too large, whereas, it is too small on others. On 
some machines this scaling leads to distortions in the display. On some computers the 
scaling causes problems with the drop-down menus not scrolling the full set of 
chemicals or landscapes. If the worksheet or drop-down menus are distorted or appear 
too large or small, it may be necessary to use the Excel "Zoom" function to change the 
display scaling. When printing, the scaling should not be set above 90%. In Excel 4.0, 
the "Zoom" function is under the "Window" menu, and in Excel versions 5.0 and 
later, the "Zoom" function is under the "View" menu. 

On some PC computers, the words appear chopped off or#### is found instead of a 
number in one or more cells. This is because personal computers do not handle video 
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displays identically. This is an annoying situation, but we have not seen a PC display 
in which one cannot see all of the important information. You may "uncover" words 
or numbers by increasing the column width. This is done by moving the pointer to 
the column heading letter area. Point at the line on the right hand side of the column 
to be widened (the pointer will become another symbol), press the mouse button, and 
"pull" the column wider. This will affect how much of the page you will see on the 
screen and printed on a single page, but it will affect only the current worksheet. 
Future worksheets will appear with the chopped off words and#### symbols. 

Print-Preview, Print-Scaling, and Page Setup 

The CalTOX worksheet is preset to print on 18 pages at 100% of full size in black and 
white. Sometimes these settings can result in loss of information or can cause 
distortion on the printed pages or in Excel "Print Preview." The "Page Setup" function 
in the "File" menu can be used to change these settings on the "Print" function under 
the "File." However, when print scaling goes above 90%, the automatic page breaks in 
the CalTOX worksheet may not work, resulting in more than 18 pages being created 
and page breaks in the wrong places. 

Memory Problems 

Memory allocation may be a problem when using CalTOX on IBM-compatible 
computers. This generally occurs when you try to run CalTOX after opening other 
spreadsheets. This is not unique to CalTOX but is a general problem affecting 
Windows and Excel. If you get an error message like "Insufficient Memory", quit the 
applications and exit from Windows to DOS. Then enter Windows again. This 
should enable you to run CalTOX. 
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!Js. SPREADSHEET STRUCTURE 

The CalTOX worksheet has 18 pages arranged in six rows and three columns. Page 
breaks in the worksheet display are marked by heavy gray lines. Page one is the 
"Home page" and contains summary results and some of the inputs relating to target 
risk, time to start the calculation, and initial concentrations. Pages 2 through 6 make 
up the remainder of the first column and serve as input fields for chemical properties, 
landscape properties, and human exposure factors used in the model. 

The second column is devoted to the display of results from the multipathway 
exposure assessment. At the top of this column is the exposure histogram that relates 
potential doses by route to the environmental medium that contributes to that 
potential dose. The remainder of this column includes the table of "toggle-switch" 
cells used to turn pathways on and off, the potential-dose matrix, the matrix of 
exposure media concentrations, the cumulative-dose table, and information for offsite 
transfers. 

The third column is devoted principally to the information needed and intermediate 
outputs for the multimedia fugacity mass-balance model. However, the first page in 
this column includes a list of all secondary input parameters. These are model 
parameter values that are calculated from model inputs listed on pages 2 through 6. 
This is followed by a list of any warnings and error messages that have been triggered 
by the calculation. The remainder of the column is devoted to the fugacity model and 
includes tables of fugacities and fugacity capacities, diffusion and advection rate 
constants, gain-loss tables for each compartment, compartment-specific rate constants, 
and a table and graph of concentration versus time in the root-zone and vadose-zone 
compartments. 

Figure 2 provides a schematic of the 18-page CalTOX worksheet. 

The "Home" Page 

The home page of the CalTOX worksheet contains summary results and some of the 
inputs relating to target risk, time to start the calculation of population exposures and 
initial concentrations. At the top of the page is information on the version of the 
CalTOX template used. Below this is the problem summary that includes the name of 
the chemical used in the calculation, the name of the landscape-data set, and the name 
of the exposure factors set used for the calculation. 
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Home page Exposure histogram Calculated properties 

Inputs Outputs 

Page 1 Page 7 Page 13 

Chemical properties Exposure pathway on/ off Calculated properties, warnings, 
Toggles and error messages 

Page2 Page 8 Page 14 

Chemical properties Potential-dose matrix Fugacities, compartment 
(continued) and Landscape volumes, and fugacity capacities 
properties 

Page3 Page 9 Page 15 

Landscape properties Exposure-media concentrations Diffusion and advection rate 
(continued) table constants 

_page 4 Page 10 Page 16 

Landscape properties Table of time-dependent Compartment gains and losses, 
(continued) and Exposure cumulative doses within the residence times, inventories, and 
factors population concentrations 

PageS Page 11 Page 17 

' 

Exposure factors Information for offsite transfers Time dependent compartment 
(continued) inventories in the soil layers 

Page 6 Page 12 Page 18 

Figure 2. The 18 pages in the CalTOX worksheet and how these pages are arranged into 
three columns and six rows in the worksheet. 
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Inputs on the Home Page 

The "input" section of the Home page lists important inputs that control the 
calculation of risk for both the continuous emission and contaminated soil versions of 
CalTOX. Figure 3 illustrates the input displays on the home page. 

Drop down menus 
to select input data 

Inputs that are taken 
by default from the 
chemical data file 

Inputs that are 
entered by the user 
to specifytime and 
health risk targets 

>
Inputs that define initial 
concentrations in soil 
layers (shown only in the 
contaminated soil model) 

> 
Inputs that define 
continuous inputs such as 
air emissions or pesticide 
application 

Information for offsite 
transfers 

Figure 3. Inputs listed on the home page (based on the contaminated soil model). 
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Outputs on the Home Page 

The major outputs from a CalTOX calculation are summarized on the right side of the 
Home page and include a window for any warning messages. In the contaminated-soil 
version of CalTOX there is a summary of soil clean-up targets based on the target risk 
and the target hazard ratio. Soil clean-up numbers based on risk are calculated both for 
the individual exposed for the exposure duration without having any exposure to 
breast milk and for the individual who is exposed for the first year of the exposure 
duration to contaminants in breast milk. Similarly, clean-up goals for non-cancer end 
points are based separately on the breast-feeding infant and the adult. Recommended 
target soil concentrations at the far right are minimum values in root and vadose soil 
of target concentrations based on risk and hazard and infant and adult exposures (these 
are only shown in contaminated soil model). 

Root-zone soil . 
Vadose-zone soil 

Groundw¢er 
Surface water. · 

Sediment , :..; ,· ;... ··-..." ~. ~ 

Figure 4. Outputs listed on the home page (this figure is based 
on the contaminated soil model) . 
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The soil clean-up goal is based on a target risk or hazard. The estimated lifetime risk is 
based on a time-weighted average exposure over the exposure duration (ED), which is 
specified among the exposure factors loaded from DatCal and listed on page 6 of the 
CalTOX sheet. The hazard is based on the maximum exposure rate value computed 
over the exposure duration (ED). The soil clean-up goal is based on how much the 
initial soil concentration must be reduced to meet the target lifetime risk. Thus, this 
output column specifies both the estimated risk without soil cleanup as well as the soil 
concentrations required to meet the target health goals. Because the reverse 
calculation of risk is meaningless if the concentration of contaminant in soil solution 
or groundwater exceeds the solubility limit in water, solubility limits in soil and 
groundwater are listed in this output summary. 

Target soil concentrations are labeled "invalid" when: 1) the target soil concentration 
exceeds the solubility limit in a soil layer (the term "> cone. limit" will appear in the 
boxes for target clean-up concentrations); 2) the groundwater-recharge value is 
negative; or, 3) the groundwater-recharge value is too large. 

The unmitigated risk is labeled "invalid" when: 1) the initial concentration of 
contaminant in the root- or vadose-zone exceeds the solubility limit; 2) some other 
parameter in the model is detected to be out of range; or, 3) the estimated risk exceeds 
0.1. For any of these situations, an error message appears in the error window as 
shown below. 

otE-- Error message 
window 

~~':--:'i< I 
These numbers are not 
valid because some 
intermediate parameter 
value is out of range. 

When the unmitigated risk exceeds 0.1, the forward calculation of risk cannot be 
estimated as the product of dose and potency because of the non-linearity of the dose­
response model in this range. 
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However, the calculation of target soil clean up values is usually valid, even when the 
forward calculation of risk has been labeled as invalid. In this case the display at the 
top of the following page appears. 

Un-mitigated risk and/or hazard ratio 
Warning message is triggered 
because the risk can no longer be 

of-----+-
--:----f 

Risk appro ximated as a product of dose 
Hazard ratio and potency . 

When there are no potency values or allowable daily intakes specified for a chemical, 
the term "n/ a" appears in the appropriate box for the clean-up value. 

The warning message is also triggered to display a less severe message, when non 
critical-parameter values go beyond limits that are stated in the model assumptions of 
the CalTOX reports . 

:Un-mitigated risk and/or hazard ratio 

This is often not a critical problem. Using the CalTOX menu bar to select the 
"Warnings" command or double clicking on this message will take the user to the 
table of warning messages to identify the source of the problem. 

Parameter Value Inputs 

All inputs to the CalTOX worksheet are entered in the seven-column format shown in 
Figure 5. The first column is used to describe the input parameter including units . 
The second column lists the symbol used in the spreadsheet to represent that 
parameter. Symbols in bold with a "-" to the right indicate parameters whose values 
can be estimated from default estimation methods when the mean value is set to -99. 
The third column is a formula column and displays the value used in a CalTOX 
calculation based on the mean value, estimation methods and/ or the value selected 
for adjusting this input as part of the sensitivity or uncertainty analysis. The first three 
input columns are locked and cannot be modified by the user. Columns four and five 
are open to modification by the user. The fourth column lists the expected value of an 
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Odanol-water part ition toefficie 
Meltin g point (K) 

Vapor Press ure in (Pa) 

Solubilit~ in mollm3 
Henry's law constant (Pa-mA3.1mol) H-

Diffusion coeffici ent in pure air (m21d) Dair 
Diffusion coefficient pure wate r (m21d) Dweter 

A short description 
of the input 
parameter 
including units 

The parameter symbol. 
Symbols in bold followed by a 
"-"indicate parameters whose 
values can be estimated from 
default algorithms when the 
mean value is set to -99. 

1.51E.,.CI1 
2.!9E+J2 
1 . 27E+D-~ 

2.25E+J1 
5.l4E+CI2 
7.56E-01 

963E-05 

J ~ 

Mean value 
of the input 
parameter 

The value used in a 
CaiTOX calculation 
based on the mean 
value, estimation 
methods, and/or any 
additional adjustments 

Figure 5. The arrangement of input columns in CalTOX. 

0.2 <~ 

0.03 
0.04 
0.06 
O.H< 
o.m: 
0 2!) 

J ~ 

Coefficient 
of variation 
of the input 
parameter 

An adjustment factor 
used to change the 
value used by CaiTOX 
for sensitivity and 
uncertainty analyses 

input based on uncertainty and/ or variability. The fifth column lists the coefficient of 
variation--the ratio of standard deviation to the mean, which reflects the variance in 
the input parameter due to uncertainty or variability. Column six can also be modified 
by the user and includes an adjustment factor to the value of a parameter that is used 
in sensitivity and uncertainty analyses. On the computer screen, this column contains 
different colors to indicate the underlying assignment of a distribution. No 
background color indicates no pre-assigned distribution; light blues means a pre­
assigned, independent lognormal distribution; light-blue with a red marker in the 
upper right corl!er indicates a distribution correlated with some other variable; and 
dark gray indicates a truncated lognormal distribution. These colors may look 
different on different computers. The last column is also not locked and can be used to 
make any internal modifications to value units and to list additional input 
information. 

Multimedia Transport Model Inputs 

The CalTOX multimedia transport and transformation model uses two sets of input 
data, one describing the properties of the contaminant and the other providing 
properties of the environment or landscape receiving the contaminants. 
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The needed physical-chemical properties include molecular weight; octanol-water 
partition coefficient; melting point; solubility, Henry's law constant or vapor pressure; 
diffusion coefficients in pure air and water; and intermedia distribution coefficients, 
such as Kd and K0 c- Also required are media-specific transformation rates. The types 

of data needed to construct a landscape data set include meteorological data, 
hydrological data, and soil properties. The chemical inputs are on page 2 of the 
CalTOX worksheet and the landscape data are on pages 3 and 4 of the worksheet. 

The Human Exposure Model Inputs 

The types of data needed to carry out the exposure assessment include exposure 
duration and averaging time, anatomical and dietary properties, food consumption 
patterns, activity patterns and exposure times, household parameters, other human 
factors such as soil ingestion and breast milk intake, and parameters associated with 
food crops and food producing animals. In addition, the calculation of intermedia 
transfer factors requires that a number of partition factors be available. Human 
exposure factors data is listed on pages 5 and 6 of the CalTOX worksheet. 
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6. THE CALCULATION OF RISK AND SOIL 
CLEAN-UP GOALS 

The Forward Calculation of Potential Dose and Risk 

As expressed by the equation below, CalTOX constructs the distribution of individual 
lifetime risk attributable to cumulative exposures over the duration ED (years), to a 
contaminant in soil at an initial (time zero) concentration, C5 (0) [mg/kg(soil)] . This is 

done by integrating the soil concentration in time and then summing the dose and 
effect attributable to this soil concentration over exposure routes, over environmental 
media, and over exposure pathways. 

H(ED)~C,(O)x ,1,. k~~" · ,IJ Qj(ADD;jkH :~~~: )x E[<I>[C,(OH ck.,]dt] 
m ental rnedta 

media 

In the above expression, <l>[C5(0)---7Ck,t] is the multimedia dispersion function that 
converts the contaminant concentration, C5 (0), mg/kg measured in soil at time zero, 
into contaminant concentration, Ck, at a time, t, in environmental medium, k (units 

of Ck are mg/kg for soil, mg/m3 for air, and mg/L for water). (ADDijk/Ck) is the unit 

dose factor, which is the average daily potential dose (over a specified averaging time) 
from exposure medium, i, by route, j (inhalation, ingestion, dermal uptake), 
attributable to environmental compartment, k, divided by the normalizing 
concentration Ck, which is a constant or representative average concentration over the 

·, 

duration, ED. The exposure media summation is over the number of exposure media 
that link potential dose by route, j, to contaminants in compartment, k. Qj(ADDijk) is 
the dose-response function that relates the potential dose, ADDijk' by route j to the 

lifetime probability of detriment per individual within the population, (mg/kg-dt1. 

When an environmental concentration is assumed constant over the exposure 
duration, ED, the population-averaged potential dose (for ingestion or inhalation 
routes) or absorbed dose (for dermal contact) is the average daily dose rate (ADDijk), in 

mg/kg-d given by 
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In this expression [CJCk] is the intermedia-transfer ratio, which expresses the ratio of 
contaminant concentration in the exposure medium i (i.e., personal air, tap water, 
milk, soil, etc.) to the concentration in an environmental medium, k (ambient-air 
gases or particles, surface soil, root-zone soil, surface water, and ground water) and 
[IUi/BW] is the intake or uptake factor per unit body weight associated with the 
exposure medium, i, and route j. For exposure through the inhalation or ingestion 
route, [IUi/BW] is the intake rate per unit body weight of the exposure medium such 

as m3(air)/kg-d, L(milk)/kg-d, or kg(soil)/kg-d. For exposure through the dermal 
route, [IUi/BW] is the uptake factor per unit body weight and per unit initial 

concentration in the applied medium (L(water)/kg-d or kg(soil)/kg-d). EF is the 
exposure frequency for the exposed individual, in days per year; ED is the exposure 
duration for the exposed population, in years; AT is the averaging time for the exposed 
population, in days; and Ck is the contaminant concentration in environmental 
medium k. 

The Reverse Calculation of Soil Clean-Up Goals 

CalTOX is designed to also carry out the reverse calculation of soil concentration 
linked to a specified risk. That is, what concentration in soil, C5(0), measured today is 

acceptable, giventhat our goal is to maintain our risk, H(ED), within the population at 
some time, T , in the future a tor below a target risk of H*? In this case, we calsulate a 

* target cleanup goal C
5
(0) according to 

* 
~(0)- H 

s - f (ADD·"k) T+ED l 
. L - ·I, ·. L lQj(ADDijk) X 

17 
X J{<I>[C5(0) '--7 Ck,t)]}dtj 

J routes, k environ-, 1 expo7ure . ED X C k T 
medta · 

mental ·, 

media 

CalTOX wc,ts designed to make this calculation using a multimedia, multiple pathway 
approach. ·In addition, CalTOX is capable of accepting a Monte Carlo add-on function 
so that the forward projection of risk or the reverse calculation of soil concentration 
can be determined probabilistically. This allows the specification of a level of certainty 
associated with the target risk and the target cleanup level. 
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117. SENSITIVITY ANALYSIS 

The goal of a sensitivity analysis is to rank the input parameters on the basis of their 
contribution to variance in the output. Sensitivity analyses can be either global or 
local. A global sensitivity analysis quantifies the effects of variation in parameter 
values over their entire range of values. In a global sensitivity analysis, the variance in 
the outcome is compared to the variance of the inputs. A global sensitivity analysis , 
often uses a local sensitivity analysis as a starting point. A local sensitivity analysis is 
used to examine the effects of small changes in parameter values at some defined 
point in the range of outcome values. As an example, one can use a local sensitiyity 
analysis to make preliminary sensitivity rankings for model input parameters by using 
the partial derivatives of each input variable normalized according to therelationship, 

where Dsi is the differential sensitivity factor for the i th parameter; oY/ 8Xi is the 
partial derivative of the output, Y, with respect to the variable, Xi, evaluated at the 

0 
reference or base-case value of Y and Xi, and Y0 and Xi correspond to the base-_case · · 

values of the variables, Xi, and the output, Y., An alternate normalization procedureis 

to multiply by CVi X~ /Y0 in place of X~ /Y0
, where CVi is the ratio of the standard 

deviation to mean value for the ith input parameter, that is <Jx/X~ . This alternate 

normalization gives a sensitivity score as follows 

0 
.. . .. ·ay.. x. .. 

Sensitivity SCOre = __ X CVi -
1

, 
axi yo'-

The sensitivity analysis calculation in CalTOX compiles a summary of the differential 
sensitivity factor and the sensitivity score for every model input and lists ~thi~ 
information in an output file with a user-~pecified name. 
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lis. UNCERTAINTY ANALYSIS 

Parameter Uncertainty Analysis 

Describing uncertainty in the output variable, Y, involves quantification of the range 
of Y, its arithmetic mean value, the arithmetic or geometric standard deviation ofY, 
and upper and lower quantile values of Y, such as 5% lower bound and 95% up.per· 
bound. Convenient tools for presenting such information are probability 
distributions, such as, the probability density function (PDF) or the cumulative 
distribution function (CDF) for Y. However, the PDF or CDF of Y can often only be 
obtained when we have meaningful esti:rnates of the probability distributions of the 
input variables xi. ' <) 

There are five main steps in a parameter uncertainty analysis (IAEA, 1989). These 'are 
described below. 

(1) Identify the input parameters that could contribute significantly to the uncertainty 
in the predictions of outcome by a model. Care should be exercised at this point not to 

' ~, 

discard potentially significant uncertainties without good cause. · 

(2) Construct for each parameter a probability density function both to define the 
range of values that a parameter can take on and to reflect the belief that the parameter 
will take on the various values within that range. 

(3) Account for dependencies (correlations) among the parameters. 
' ' ~ .. 

(4) Propagate the uncertainties through the model to generate a PDF of predicted 
outcome values;· · ,,_, :·--, -<•·r:•· 

'·l ' 

(5) Derive confidence limits and intervals from the PDF of predicted values of the 
outcome variable in order to provide a quantitative statement about the effect 'of. 
parameter uncertainty on the model predictions. 

CalTOX has been designed to carry out these steps using the CalTOX worksheet and an 
add-in Monte Carlo program such as Crystal Ball (Decisioneering, 2000). 
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Monte Carlo Analysis 

In a Monte Carlo analysis, each of the input parameters is represented by a probability 
density function that defines both the range of values that the. parameter can take on 
and the likelihood that the parameter has a value in any subinterval of that range. 
Latin hypercube sampling is a Monte Carlo method that uses stratified random 
sampling to select a value from each parameter's distribution. Whereas for simple 
random sampling it is often a matter of chance how evenly the selected values cover 
the range of the input parameter, latin hypercube sampling places restrictions on 
possible unevenness. Additional. information on latin hypercube sampling. is 
available in Iman and Shortencarier (1984 ) and the user's manual for Crystal Ball . 

Uncertainty Analysis with CalTOX 

An uncertainty analysis can be performed on any CalTOX spreadsheet by adding in a 
Monte Carlo program, such as Crystal Ball. Because some of the output cells in the 
Cal TOX spreadsheet contain non-numerical values:the following warning is 
sometimes generated after the Crystal Ball program runs. 

One or more ualues resulting from 
calculation errors had to be discarded. 
You may wish to check your formulas 

· and assumptions for diuision by o; etc. 

n OK D Help 

When this message appears, it is most likely due to this situation. Nonetheless, this 
message should not necessarily be ignored. In order to prevent the program from 
stopping, do ·not select the -"stop on calculation error" -command under the stopping 
criteria in the "run" menu. 

More-detailed information on how to carry out an uncertainty analysis using Crystal 
Ball and the CalTOX worksheet can be obtained by reading the Crystal Ball version 4.0 
User manual (Decisioneering, 2000). 
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